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How to Use this Handbook 
This guide has been designed to provide instructors and other higher education content creators, such 
as instructional designers, with an overview of accessible design concepts. Its content is based on the 
most recent version (2.1) of the World Wide Web Consortium’s Web Content Accessibility Guidelines, as 
they pertain to online course design.  

The Online Course Accessibility Checklist provided on the next two pages has been positioned at the 
beginning of this handbook as a quick reference to help you evaluate the accessibility of your courses. 
However, the Checklist may also be a useful tool in helping you become more aware of which accessible 
design skills you may need to learn. The topics presented in this handbook are divided into scaffolded 
parts. 

It is the hope of the VLC that you will find this handbook and the information therein useful. Please 
contact us if you are interested in receiving professional development. 

Topics Discussed in this Handbook: 

● Part 1: What is Digital Accessibility? 
If you’re new to digital accessibility, Part 1 will help you understand why authoring accessible 
digital content is important and who benefits from these efforts. 

● Part 2: Foundational Concepts of Digital Accessibility 
This section provides an explanation for each of the items listed in the Online Course 
Accessibility Checklist. The intention of Part 2 is to help you understand how each item in the 
checklist contributes to digital accessibility compliance.  

● Part 3: Applying Foundational Concepts to Course Design 
This section’s simple DO THIS / NOT THIS format is intended to provide you with a quick 
reference of what to do and what not to do as you design online courses. 

● Part 4: Authoring Digitally Accessible Word Documents 
This section provides step-by-step instructions for creating digitally accessible Word documents. 
Information on color contrast, structure, hyperlinks, accessible images, and tables is provided. 

● Part 5: Authoring Digitally Accessible PowerPoint Presentations 
This section provides step-by-step instructions for creating digitally accessible PowerPoint 
presentations. Information on color contrast, structure, hyperlinks, accessible images, and 
tables is provided. 

● Part 6: A Note on Universal Design for Learning 
This section provides an introduction to Universal Design for Learning (UDL) and makes the 
connection between digitally accessible content and one of UDL’s primary principles. 

● Part 7: Resources 
This section contains additional resources related to the topics and information discussed in this 
handbook. 

Special Acknowledgements 
Thank you to Wake Technical Community College for providing accessibility examples contained in this 
guide and to Durham Technical Community College for updating the content. 
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Online Course Accessibility Checklist 
This checklist follows WCAG 2.2 AA guidelines and is intended to serve as a guide in evaluating online courses for ADA 
accessibility compliance. It contains 43 items divided into six categories: Color, Contrast, and Text/Font Style; Structure; 
Images; Hyperlinks; Multimedia; and File Names.  

Color Contrast, Use of Color, Text/Font Style  

● Strong color contrast is present between the foreground (text or graphics) and the background. The content is 
readable. 

● Color combinations that seem to vibrate or create an after image are avoided. 
● Black text on a red background or red text on a black background is avoided. 
● Images required to understand content have sufficient color contrast. 
● Color used to emphasize or convey information is supplemented with secondary formatting. 
● Color-coding is supplemented with a secondary mechanism, such as a shape or symbol. 
● Basic, simple, easy-to-read fonts are used. 
● Real text, NOT text in a graphic, is used whenever possible. 
● Blinking or moving text is avoided. 
● Text content is NOT locked; students can customize paragraph spacing, letter spacing, word spacing, and line 

height. 

Structure 

Word Documents  

● The document is organized with Heading styles. 
● Lists are structured with Word’s bulleted or numbered list options.  

PowerPoint Presentations  

● The presentation was created with built-in slide layouts. 
● Lists are structured with PowerPoint’s bulleted or numbered list options. 
● All text content appears in Outline View. (Note: content in tables will not appear in the Outline View pane). 
● Information appearing in the Outline View is in the same order as it appears on the slides. 
● Each slide has a unique title. 

Tables  

● Tables have a designated header row and include a title. Verify the reading order using the Tab key. 
● When the table contains information that is more complex or abbreviated, more explanation in the form of a 

long description, is provided near the table. 
● All cells contain content; blank cells are avoided. 
● Cells are not merged across rows or columns. Cells have not been split. 
● When a table extends beyond one page in a document, the rows are restricted from breaking across 

pages. 

Learning Management System (LMS) Content 

● Content typed in the text editor is organized with Headings styles.  
● Lists are structured with one of the text editor’s List commands. 
● Course navigation is simple and consistent. 

CONTINUED ON NEXT PAGE  
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Images 

Alternative Text  

● Alternative text is provided for all images, charts, graphs, and diagrams. 
● The alternative text is meaningful and sufficiently “replaces” the images, charts, graphs, and diagrams. It is 

succinct, generally between 5 and 15 words (or about 125 characters).  
● All instances of Word Art in the Word document or PowerPoint presentation have been replaced with 

real text or an alternative text is provided.  

Long Description (when needed) 

● An indication of where to find the longer description is provided in the alternative text for ALL complex images, 
such as charts, graphs, and diagrams. 

AND OPTION A 

● A long description is typed near complex images, charts, graphs, and diagrams. (Note: In PowerPoint, compose 
the long description in the slide’s Notes area.)  

OR OPTION B 

● A link to the image’s long description is provided before or after the complex image, chart, graph, or diagram. 

Hyperlinks  

● All hyperlinks should be readable, descriptive, and convey the purpose of the link. (e.g., Where is the link going? 
What content is the link providing?) 

● Hyperlinks that open another application or web browser tab are clearly indicated as such in the hyperlink’s 
clickable text. 

● If students will likely print the content, the URL/web address for each hyperlink is provided. 

Multimedia  

● Embedded (or linked) videos are captioned. Audio description (narrative description of on-screen visuals) is 
provided when needed.  

● A transcript is provided for each video and audio recording (e.g., Films On Demand, YouTube, a podcast). 
● Avoid the audio and video player auto-start (and looping) feature. 
● When necessary, provide a link to relevant video/audio plugins. 
● Internet resources, including videos, can be navigated or operated with the keyboard alone.  

Accessible File Names  

● File name uses alphanumeric (abc, ABC, 123) characters.  
● File name does NOT include spaces. 
● File name does NOT include special characters, such as: &, ( ) % # $ ¢ / \ { } [ ] < > : ; @  
● You may use the hyphen (-). It is preferred over the underscore ( _ ). 
● File names should be under 31 characters. 

END OF CHECKLIST
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Part 1: What is Digital Accessibility? 

In order to understand what digital accessibility is, it’s important to first understand that consumers of 
digital content, such as your students, may access that content in a number of ways. Some might use 
computers, others laptops, and some might use their mobile devices. However, students with some 
types of disabilities may also use another layer of technology, called assistive technology, to help them 
use their computer equipment and access digital content. 

What is assistive technology? 

The federal definition of assistive technology (AT) is:  

“...any item, piece of equipment, or product system, whether acquired commercially off the shelf, 
modified, or customized, that is used to increase, maintain, or improve functional capabilities of 
individuals with disabilities” [20 U.S.C. Chapter 33, Section 1401 (25)]. 

Examples include, but are not limited to: 

● Screen reading technology 
● Refreshable braille display 
● Screen magnifier 

What are some of the potential accessibility barriers for assistive technology 
users in online classes? 

When the digital content (or the platform hosting it) is inaccessible, students with disabilities may run 
into a host of problematic barriers, such as: being completely blocked from accessing any content in an 
inaccessible PDF, being unable to find particular sections in an important study document, being unable 
to perceive information an instructor provides in an audio recording, or many other potential barriers.  

What is Digital Accessibility? 

According to a policy brief from the Southern Regional Education Board… 

Digital accessibility ensures the ready availability and usability of content, websites and 
processes on computers and electronic devices for all users, including those with hearing, 
visual, motor or cognitive impairments. 
(Source: Expanding Accessibility to Digital Spaces Through Improved Policy and Practice [opens new 
window], SREB, March 2017) 

As mentioned above, individuals with disabilities may access digital resources using various assistive 
technology tools; however, these tools work only when the content and systems being accessed adhere 
to accessibility standards. Providing guidance on many of these standards, as they pertain to online 
course design, is the goal of this handbook. 

https://www.sreb.org/publication/expanding-accessibility-digital-spaces-through-improved-policy-and-practice
https://www.sreb.org/publication/expanding-accessibility-digital-spaces-through-improved-policy-and-practice
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Who Benefits from Digital Accessibility? 

Though the primary beneficiaries of digital accessibility efforts are students with disabilities, the benefits 
of such efforts are often extended to all students.  

For example, providing closed captioning for a video allows a person unable to perceive the video’s 
audio content access to it via a text representation (the closed captions). People this digital accessibility 
measure benefits include: hearing impaired and deaf students; students studying in places where a 
video’s audio is difficult to hear, such as a café or library; students needing to watch a video featuring 
people with unfamiliar accents, learning impaired students, and second-language learners. 
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Part 2: Foundational Concepts of Digital Accessibility 

This section contains a brief explanation for each digital accessibility guideline outlined in the Online 
Course Accessibility Checklist. This information is provided to help answer the question of “why?” for 
each digital accessibility guideline. 

Color Contrast 

 Strong color contrast is present between the foreground (text or graphics) and the 
background. The content is readable. 

Students with low vision or colorblindness need sufficient contrast between the foreground 
(text or graphics) and the background. Good contrast also benefits mobile users.  

Tip: If you’re unsure of the color contrast, use TPGi’s free Color Contrast Analyzer to check the 
contrast of your foreground and background colors (see Part 7 for a link to the TPGi Color 
Contrast Analyzer.) 

 Color combinations that seem to vibrate or create an after image are avoided. 

Placing areas of brightly colored hues together can cause an afterimage effect (or “visual 
vibration”), which makes it difficult to focus on the content. 

 Black text on a red background or red text on a black background is avoided. 

Some students with color blindness lack the ability to detect the lower color wave frequencies 
associated with red; red appears black, so this combination should be avoided.  

 Images required to understand content have sufficient color contrast. 

When a graphic is essential for understanding content, then the image should be perceivable 
by students with low vision or other impairments without the need for contrast-enhancing 
assistive technology. 

Use of Color 

 Color used to emphasize or convey information is supplemented with secondary 
formatting. 

Students unable to distinguish between colors rely on secondary formatting as cues to help figure out 
emphasis or meaning.



Page 12 
 

 Color-coding is supplemented with a secondary mechanism, such as a shape or symbol. 

Students unable to distinguish between colors rely on shapes or symbols as cues to help figure out 
content. This is an especially beneficial revision to graphs and charts that would otherwise rely on color 
alone to convey data or information. 

Text Considerations 

 Basic, simple, easy-to-read fonts are used. 

Use fonts that are available by default in modern operating systems. Avoid decorative, frilly fonts. Good 
options to consider are: Arial, Calibri, Tahoma, Trebuchet MS, and Verdana. 

 Real text, NOT text in a graphic, is used whenever possible. 

When text is actually an image, it cannot be read by a screen reader. Providing an alternative text for 
the image may be an option; however, using real (typed) text is the recommendation because when the 
image needs to be significantly enlarged for students with low vision, real text will not become distorted 
or unrecognizable as text in an image might. 

 Blinking or moving text is avoided. 

Text that blinks or moves can be distracting to all learners and especially so for learners with attention 
deficits or cognitive disabilities. Additionally, for those susceptible, there is a possibility that blinking text 
will trigger a seizure. 

 Text content is NOT locked; a student can customize paragraph spacing, letter spacing, 
word spacing, and line height. 

Whenever possible, allow students the flexibility to change the text formatting of digital content to meet 
their own needs for readability. 

Structure: Text Content 

 The text content is organized with Heading styles. 

People with vision impairments rely on headings to provide an outline of the content that allows them 
to easily navigate through text and documents. A screen reader does not recognize text formatting (e.g., 
bold, large font size) as a meaningful heading until a Heading style has been applied. 

 Lists are structured with build-in bulleted or numbered list options.  

People with vision impairments rely on structured lists to determine how many items a list contains. 
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Structure: PowerPoint Presentations 

 The presentation was created with built-in slide layouts. 

The placeholders in slide layouts provide slide structure. Placeholders may be rearranged on a slide; 
however, it is important to check Outline View to verify the sequential order of the slide’s content. 

 Lists are structured with PowerPoint’s bulleted or numbered list options. 

People with vision impairments rely on structured lists to determine how many items a list contains. By 
default, a bulleted list is created when first typing in a placeholder. This can be changed to another list 
format, if desired. 

 All text content appears in Outline View. (Note: content in tables will not appear in the 
Outline View pane). 

Any text typed in a slide’s placeholder appears in Outline View. Verifying that all of the text content is 
appearing in Outline View is a useful way to confirm that assistive technology is able to access all of a 
slide’s text content. Any content appearing in author-created text boxes will not appear in Outline view 
and may not be accessible by assistive technology users. 

 Information appearing in the Outline View is in the same order as it appears on the 
slides. 

At first glance, a slide’s content may appear logically sequenced; however, viewing the presentation as a 
text outline in Outline View, will make it apparent when content has inadvertently been placed out of 
order. Screen reader users depend on logically sequenced content. 

 Each slide has a unique title. 

Slide titles function much like document Headings, allowing for quick navigation. They are assigned bold 
formatting when viewed in Outline View. The title of each slide should reflect the slide’s content.   

Structure: Tables  

 Tables have a designated header row and include a title. Verify the reading order using 
the Tab key. 

Designating a header row ensures that the first row will be designated as column titles. Including a title 
introduces the table and provides some context for it. Checking the reading order using the Tab key 
makes sure that the table is not an image and that it will be read by a screen reader.
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 When the table contains information that is more complex or abbreviated, more 
explanation as a long description is provided near the table. 

Students with visual impairments or blindness will be unable to see any visual cues that might be 
present in a complex data table and it should not be assumed that students know the meaning of all 
abbreviations. Providing a long description to help provide this important information to students will 
help all of them more easily understand the information in the table. 

 All cells contain content; blank cells are avoided.  

Instead, type blank cell or data not available. You may change the font color to blend the text in with the 
background, if desired. 

 Cells are not merged across rows or columns. Cells have not been split. 

Avoid controlling the spacing in your table with blank rows or columns. Adjust line spacing instead. 

 When a table extends beyond one page in a document, the rows are restricted from 
breaking across pages. 

When a table becomes large enough that it needs an additional page to display all of the content, 
restricting the table’s ability to break rows across pages will help keep each row’s information intact and 
make the table easier to follow as it goes on to the next page.  

Structure: Learning Management System (LMS) Content 

 Course navigation is simple and consistent.  

Keeping content within three clicks of the main (or Home) course page will allow students to more easily 
locate course material.  

Images: Alternative Text 

 Alternative text is provided for all images, charts, graphs, and diagrams. 

Screen reading software is unable to interpret images, charts, graphs, and diagrams. The image’s 
alternative text (alt text) is instead accessed by the technology and is read aloud to the student. 
Providing alt text allows the content and function of images and other visual elements to be accessible 
to those with visual or certain cognitive disabilities.   

 The alternative text is meaningful and sufficiently “replaces” the images, charts, graphs, 
and diagrams. It is succinct, generally between 5 and 15 words (or about 125 characters).  

For a student unable to see the image, a meaningful replacement allows the student to conceptualize 
the image’s content. 
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 All instances of Word Art in the Word document or PowerPoint presentation have been 
replaced with real text or alternative text is provided.  

When text is actually an image, like Word aArt, it cannot be interpreted by a screen reader. Providing an 
alternative text may be an option; however, using real (typed) text is the recommendation because 
when the image needs to be significantly enlarged for students with low vision, real text will not become 
distorted or unrecognizable as it might in a Word Art image. 

Images: Long Description 

 An indication of where to find the longer description is provided in the alternative text 
for ALL complex images, such as charts, graphs, and diagrams. 

Providing the location of a long description in the complex image’s alternative text helps students who 
use screen readers find the image’s long description. 

PLUS, THIS OPTION 

 A long description is provided near the complex image. (Note: In PowerPoint, compose 
the long description in the slide’s Notes area.) 

The content of some images can be more complex than what the image’s succinct alternative text can 
provide, especially when the images are instructional in nature. For these complex images, additional 
information is needed so that students may learn what is intended from the image. Providing the long 
description near the image allows ALL students to benefit, instructionally, from it.  

OR THIS OPTION 

 A link to the image’s long description is provided before or after the complex image, 
chart, graph, or diagram. 

The option of providing a link rather than text near the image is a design choice. Providing a longer 
description on the same page or linking to it provides an opportunity for all students to learn from the 
description. To link to a long description, type the image’s description in a word processor, upload the 
document to the Resources area of your course site, and then create a link to it. 

Hyperlinks 

 All hyperlinks should be readable, descriptive, and convey the purpose of the link (e.g., 
Where is the link going? What content is the link providing?) 

Well-formed hyperlink text makes sense independently of surrounding text, informs people of the 
purpose of the link, and lets people know what will happen when the link is clicked. Note that while 
most screen reading technology announces links, it can be very helpful for learners with cognitive 
disabilities when they know that a hyperlink may open a new tab in the browser or another application. 
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 Hyperlinks that open another application or web browser tab are clearly indicated as 
such in the hyperlink’s clickable text. 

Providing the forewarning that a new tab in the web browser or that an application will open is helpful 
to all users; however, this is especially important for screen reader users because a new tab/window or 
application opening without warning can be disorienting. 

 If students will likely print the content, the URL/web address for each hyperlink is 
provided. 

It is impossible to click a link on a printed document, and so providing the URL/web address allows the 
student to type the address in a web browser. Tip: If the web address is especially long, use a URL 
shortener such as bitly.com or shorturl.at to create a shorter version. 

Multimedia 

 Embedded (or linked) videos are captioned. Audio description (narrative description of 
on-screen visuals) is provided when needed.  

Captions and audio description provide access to videos for people who are deaf, hard-of-hearing, blind, 
or low-vision. Recent research suggests non-disabled students find captions to be a useful learning aid, 
as well. Audio description is an additional audio track that provides a voice-over description of the on-
screen content. It is not a necessary addition ONLY IF sufficient verbal description of visuals is already 
provided in the video. 

 A transcript is provided for each video and audio selection (e.g., Films On Demand, 
YouTube, a podcast). 

A transcript is a text representation of aural content. It provides access to videos and audio content for 
people who have hearing impairments. Ideally, transcripts should be saved as a text document (e.g., 
with Window’s Notepad).  

 Avoid the audio and video player auto-start (and looping) feature. 

Audio or video should not automatically start upon page load or loop continuously. This is frustrating 
especially to those who rely on keyboard-only navigation and screen reading technology. These users 
must use the keyboard to navigate through the page, find the video player, and then find the pause 
button as the video or audio continues to play, often overlapping with screen readers’ voice 
synthesizers. 

 When necessary, provide a link to relevant video/audio plugins. 

When providing video or audio files for your students to download, provide any relevant plugin that will 
allow your students to access the files.
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 Internet Resources, including videos, can be navigated or operated with the keyboard 
alone. 

Course components and multimedia elements are controlled only by the user’s keyboard. This means 
pressing the Tab key should move the “focus” logically through the content appearing on screen. 
Pressing Enter (or Spacebar) should confirm a selection (you can test this by using only your keyboard – 
not your mouse – to navigate areas of your course, such as downloading an assignment or opening a 
hyperlink). 

A multimedia element (such as a video or audio recording) should not start or begin playing when the 
page in which it is located is opened. It should also be fully controllable by the user’s keyboard.
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Part 3: Applying Foundational Concepts to Course Design 

 Applying Color Contrast to Course Design 

1. Course theme or template provides strong color contrast between 
background and text. 

 
Figure 1: Blackboard examples of good  

color contrast compared to insufficient color contrast 

 
Figure 2: Moodle examples of good  

color contrast compared to insufficient color contrast
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2. Images required to understand content have sufficient color contrast. 

DO THIS 

 
Figure 3: Graphic with sufficient color contrast  

utilizing dark text on light backgrounds. 

NOT THIS 

 
Figure 4: Graphic with insufficient color contrast  

due to dark text on dark backgrounds. 
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A Note about Contrast and Orange 

Orange is neither very dark nor very light, so it is often difficult to pair with another color — with the 
exception of black. 

 

 Applying Color to Instructional Content 

1. No more than 3 different text fonts or colors are used throughout the 
course. 

DO THIS 

 
Figure 5: Example of two font colors, one of which is  

being used to denote language classifications. 

NOT THIS 

 
Figure 6: Example of confusing visual appearance when  

many font colors and font styles are used.
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2. Color is not used as the only means of conveying information. Color 
blindness is the inability to perceive differences between some colors that 
others can distinguish. 

DO THIS 

 
Figure 7: Example in which the instructor has indicated with bold formatting and  

red font the lines that must be memorized for the next quiz. 

NOT THIS 

 
Figure 8: Example in which the instructor has indicated with only red font the  

lines that must be memorized for the next quiz 

A Note about Combining Red and Black 

A common color combination used to alert or warn people is red and black. Consider the image below. 

 

A person with normal vision is able to distinguish between the red background and the black and white 
text. Both sets of text say Warning. 

Now, consider the same image as it would appear to someone with Deuteranomaly, or red-blind color 
vision deficiency. 

 

The red background appears black, which causes the black text to blend in with the background 
and disappear. The white text is still visible, but to the person with red-blindness, the text appears white 
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on a black (rather than red) background. An awareness of this limitation may help you avoid pairing red 
and black when emphasizing or conveying information to students. 

 Applying Text Considerations to Course Design 

1. Text is easy to read.  

Sans serif fonts are recommended (fonts without “feet” or other ornamentations). Calibri, Arial, 
Verdana, and Tahoma are examples of sans serif fonts: 

This is Calibri. This is Arial. This is Verdana. This is Tahoma. 
Verdana is considered the easiest to read of the basic sans serif fonts. It is larger, has more spacing 
between letters, and its characters are not easily confused. 

DO THIS 

 
Figure 9: Verdana example in a Learning Management System 

NOT THIS 

 
Figure 10: Georgia example in a Learning Management System  

(the font size was set the same as the Verdana example in Figure 9) 
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2. Real, typed text, NOT text in a graphic is used whenever possible. 

DO THIS 
Type the text directly onto the document or presentation, such as: 

Thank you! 

NOT THIS 
Avoid using a graphic of text.  

 
Without alt text, the graphic above would be unavailable to screen reading assistive technology. For this 
reason, the recommendation is to use real text typed directly in the text editor 

3. Content is not locked. 

Paragraph spacing, letter spacing, word spacing, and line height can be customized by the student to 
enhance readability. An example of locked content is a PDF document. If you wish to use a PDF, upload a 
companion Word document containing ALL of the same information to allow students to select the 
document format that is more suited to their individual technology requirements. 

4. No moving or blinking animations or text should be present in course 
content.  

Blinking/flashing elements can trigger an event in individuals who are prone to seizures. Additionally, 
blinking and animated elements are known to be distracting to all students regardless of cognitive or 
attention challenges. 

 Applying Text Structure to Course Design 

1. Content is logically structured. 

Headings and lists are used appropriately to establish content hierarchy, much like an outline for the 
content. The structure that headings and lists create is available to screen reading technology as a 
logical, hierarchical reading order.
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DO THIS 
As you apply heading styles to your content (see Figure 11), make sure to apply them logically so that a 
proper hierarchy is established. Heading levels create an outline of the content, and so it is important to 
apply them in numeric order rather than skipping levels: 

● Heading 1 
This heading style is applied to the title of a page (or content). It is the main heading and 
denotes the overall topic; therefore, it is usually used only once. 

● Heading 2  
Most of the subheadings that come after Heading 1 will receive a Heading 2 style. 
Heading 2 can be used as many times as needed.  

● Heading 3, 4, and beyond  
Your text may require additional subsections; these additional heading styles are 
available, if needed. 

 
Figure 11: Heading Styles as they  

appear in a text editor. 

NOT THIS 
Adjusting the color and size or applying bold and italics to text only changes the visual components of 
the text; it does not address structure or establish an accessible content hierarchy. 

 
Figure 12: Font size options as they  

appear in a text editor. 
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2. PowerPoint Slides have Unique Titles 

DO THIS 
If you have two or more PowerPoint slides dedicated to the same main idea, make sure all of the slide 
titles remain unique. You can do this by adding a little supplementary information to help identify how 
many slides will have a similar name.  

 
Figure 13: Series of three PowerPoint slides with unique slide titles 

NOT THIS 

 
Figure 14: Three individual PowerPoint slides with the same slide title 
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 Applying Table Structure to Course Design 

Tables are simple and have logical left-to-right, top-to-bottom reading order. 
Table headers are implemented when available. A table title helps introduce 
the content of the table. 

DO THIS 

 
Figure 15: Table displaying information about Arabian horses. 

AVOID THIS 

● Embedding a table within a table. Screen readers always read embedded content first 
and the user can easily become disoriented.  

● Empty, merged, or split cells. Their presence can cause the table to be confusing to 
assistive technology users. 

● Using tables for visual layout purposes. Tables should be used to convey meaningful 
information or data (rather than page formatting). 

The table in Figure 16 has been used to visually position content. It contains a nested table, merged 
cells, and two empty cells. Also, notice the absence of column titles indicating there is no header row. 
This table is very difficult for an assistive technology user to navigate, as well as understand. 
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Figure 16: Images of Arabian horses, a map, and a tapestry appear  
in various cells of a table. No title is provided for the table. 

 Applying Alt Text and Long Description to Course Design 

Non-text elements have meaningful alternative text and when necessary, a long 
description. 

All images require alternative (alt) text. Alternative text replaces the image for screen reader users, 
allowing the users to visualize the graphic. 

Generally, the length of alternative text is less than 125 characters (about 10-15 words).  

To create alt text, consider your purpose for using the image: 

● Is it purely decorative?  
● Is it an example of something you mention in the surrounding text/lecture?  
● Is it a more complex graphic containing important information? 
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Table 1: Considering Alternative Text for Decorative and Example Images 
Considering Alt Text  

for Decorative Images 
Considering Alt Text  
for Example Images 

Example: An architecture instructor might use 
the following image, as decoration, on a title slide 
of a PowerPoint presentation about Greek 
architecture. 

 

Example: An architecture instructor might use 
the following image, in a text lecture, as an 
example of a type of Greek column.  

 

DO THIS 
Alt Text: North face of White House mansion 
(Washington DC, USA) 
 
 
Explanation: The alt text provides a brief 
overview of the content that appears in the 
image. 

DO THIS 
Alt Text: North face of White House mansion 
(Washington DC, USA) featuring square portico 
surrounded by Ionic columns 
 
Explanation: The alt text identifies the type of 
columns and the White House as an example of 
them. 

NOT THIS 
Alt Text: Washington DC  
 
Explanation: The alt text does not provide a brief 
overview of the content appearing in the image. 

NOT THIS 
Alt Text: White House 
 
Explanation: Even though the image depicts the 
White House, the instructor is using the image as 
an example of a type of Greek column.  

NOR THIS 
Alt text: whiteHouse.jpg 
 
Explanation: Note that this is the name of the 
image file. This should be replaced with alt text 
sufficient enough to replace the visual. 
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Considering Alt Text for Complex (STEM) Images 

Alternative text AND a long description are required for more complex educational images, such as 
Science, Technology, Engineering, and Math (STEM) images. Depending on the type of STEM image, use 
one of three long description strategies: Linear Description, List Description, or Table Description. (See 
Appendix A for information on these long description strategies.) 

DO THIS 
When a long description is needed, include where to find it in the image’s alt text. 

 
Figure 17: Example in Microsoft Word of how information  
about where to find the complex image's long description  

is included as part of the image's alt text. 
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ALSO DO THIS 
Determine the format in which you want to provide the long description: 

● Option A (Ideal for instruction and Word documents): Typed under (or near) the image.  
● Option B: (A good choice for images embedded in the LMS): In a separate Word 

document or text document. You will upload the long description file to your class site’s 
Resources area, and then create a link to it under the image. 

● Option C: (In PowerPoint ONLY): Typed in the Notes area under the image’s Slide. 

An Important Note Regarding Images and Tables 

If you teach with digital materials created by someone else, such as a publisher, you may occasionally 
encounter a table that is actually an image and likely not accessible. How can you tell if this is the case? 

Part 3 and Part 4 offer additional information on how to work with images in Word and PowerPoint; 
however, performing a Tab test will allow you to determine whether or not a table's cells are available 
to assistive technology. 

DO THIS 
Perform a Tab Test 

Place the cursor in the first cell of the table. Then press the Tab key on the keyboard.  

One of two actions will occur: 

● Action A: 
The cell to the right of the first cell will gain focus by visually highlighting. Highlighting 
indicates that the contents of a cell are available to assistive technology. 

 
Figure 18: A highlighted table cell 
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● or Action B: 
A selection handle will appear around the table. If a selection handle appears, the table 
is an image and requires alternative text and very likely, a long description. (See 
Appendix A for information on how to provide long description for data tables.)

 
Figure 19: The selection handle appearing around the perimeter of the image 

 Applying Hyperlinks in Course Design 

Hyperlink text clearly states the purpose of the link. Web addresses are 
provided in text-only format. 

SCENARIO A: 
A science instructor is sending students to WRAL TV online to observe current local weather radar 
reports. 

DO THIS 
Go to the WRAL Online Local Radar (opens in new tab) 

www.wral.com/weather/radar 

AND THIS 
Hyperlinks to web resources in PowerPoint include (link) as part of the clickable text.  

Virtual Learning Community Tools and Resources (link)  

Hyperlinks in PowerPoint can be tricky for an assistive technology user to navigate. To help ensure the 
student is alerted to the presence of a hyperlink, always include: (link) as part of the active hyperlink 
text.

https://www.wral.com/weather_map_center/8106570/?default_map=radar
https://www.nccommunitycolleges.edu/it-resources-and-services/vlc-tools-and-resources
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NOT THIS 
Go to http://www.wral.com/weather/radar/ to see the local radar. 

NOR THIS 
Click here to see the local radar. 

SCENARIO B:  
A science instructor is providing a link to a PDF document of the North Carolina Climate Science Report. 

DO THIS 
North Carolina Climate Science Report (PDF) 

Hyperlinks to documents or other files indicate the type of file or content in the clickable text (e.g., 
DOCX, PDF, PPTX, TXT, etc.).  

 Applying Multimedia in Course Design 

1. All audio files should have a text transcript and appropriate user controls. 

AutoPlay should be disabled and the multimedia should NOT loop (play over and over). 

DO THIS 
● Enable user controls 
● Add a link to the transcript 
● Add link to download to the audio file, if possible 

 
Transcript of Food Bites Back (TXT) 

Download audio file: vitalSigns-FoodBitesBack.mp3 

NOT THIS 
Click here for podcasts 

  

http://www.wral.com/weather/radar/
http://www.wral.com/weather/radar/
https://ncics.org/wp-content/uploads/2020/06/NC_Climate_Science_Report_FullReport_Final_revised_May2020.pdf
https://ncics.org/wp-content/uploads/2020/06/NC_Climate_Science_Report_FullReport_Final_revised_May2020.pdf
https://ncics.org/wp-content/uploads/2020/06/NC_Climate_Science_Report_FullReport_Final_revised_May2020.pdf
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2. All videos are synchronously captioned and a transcript is provided. 

All video and multimedia content that contain speech or other necessary audio information should be 
open or closed captioned.  

Captions are a synchronous text-based representation of multimedia audio content. Open captioning 
cannot be turned on and off. Closed captioning, which is the preferred method, can be turned on and 
off. 

DO THIS 
● Video is captioned 
● Add a link to the transcript below the video 

 
Transcript of Sharing Creative Videos (TXT) 

3. Visual descriptions are incorporated into video narratives. 

When creating multimedia content, use a script to help plan your video narration to include sufficient 
verbal visual description of what the learner is being shown on screen. Your script can then be a useful 
tool in creating the video’s captions and transcript. 

SCENARIO:  
A history instructor creates a video about Southern European countries and references the following 
map of Italy. 
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Figure 20: Example map illustrating the  

content the instructor references 

DO THIS 
Instructor narration: 

“Italy’s boundaries are shaped like a boot with the city of Rome at the knee and with the toe of the boot 
pointed towards the island of Sicily. Italy is surrounded by water on three sides…” 

Detailed visual descriptions enhance learning for all students, including students who are blind or 
visually impaired. 

NOT THIS 
Instructor narration: 

“Rome is here, Sicily is here…” 
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 Applying Accessible Web Resources to Course Design 

1. Hyperlink text clearly states the purpose of the link. As a courtesy for 
printing purposes, web addresses are also provided in text-only format. 

DO THIS 
W3C: Web Accessibility Initiative (opens new tab) 

[URL: https://www.w3.org/WAI/] 

NOT THIS 

 

2. Multimedia components and controls are accessible with a keyboard (Tab 
Key test).  

Anyone should be able to use the Tab key to navigate through all elements of the course and all 
multimedia controls in the course.  

DO THIS 
To perform the Tab Key test, press the tab key repeatedly to navigate through all multimedia elements 
and controls.  

The four steps below demonstrate the Tab key test performed on a video player: 

1. To begin, Tab is pressed to locate the focus. In this example, the PLAY button has focus. It 
appears as a blue box around the button; however, depending upon the content you are testing, 
focus may appear in a different color or as a different type of box. 

 

https://www.w3.org/WAI/
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2. Pressing Tab again moves the focus to MUTE. 

 
3. Pressing Tab again moves the focus to the VOLUME control. 

 

4. Pressing Tab again moves the focus to the CLOSED CAPTIONING button.  

 

5. If it’s possible to Tab through the rest of the controls, the Tab test is considered successful.  
It is also a good idea to press Spacebar (or Enter) to make selections, such as turning on the 
Closed Captioning or press Shift+Tab to move focus back to the PLAY button and press Spacebar 
(or Enter) to start and stop the video. 

AND DO THIS 
Instructions should always be provided within the course for: 

● downloading and installing any needed plug-ins (including links to the specific plug-ins),  
● enabling captions,  
● navigating players, or for  
● accessing accessible alternatives specific to the multimedia types used within the course.
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3. External resources meet accessibility guidelines, including the availability 
of captions and transcripts. 

Internet resources, including videos and publisher ancillary material, can be navigated, operated, or 
downloaded with keyboard-only shortcuts.
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Part 4: Authoring Accessible Word Documents 

Step 1: Consider Color Contrast and Accessible Font Styles 

● When considering color contrast for text on Word’s white background, your best options are 
dark font colors, such as black or navy blue. 

● When using color to convey information, reinforce the color with text (or symbols) so people 
who cannot perceive color can access the information. 

● Fonts should be readable. 
● Limit the number of fonts.  
● Avoid using ALL CAPS or all underlined text. 

 Step 2: Structure the Document 

Apply Heading Styles 

As you create content in Word, consider the structure of your document and text. It is good design 
practice to divide longer content into sections, and then label each section with a heading or 
subheading. Applying heading styles to the title of the document or page and subheadings throughout 
the rest of the content creates accessible content structure, allowing all users to scan the document or 
content for meaning. 

Remember to nest headings appropriately to create a hierarchical outline structure.  

To Apply a Heading Style in Word: 

1. Highlight the heading (or subheading). 

 

2. On the Home tab, click the appropriate heading style from the Styles group. 

 

3. The heading style is applied. 
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Word’s Navigation Pane 

Microsoft Word's Navigation Pane displays any text that's been formatted with a Heading Style. 
Whether you're working on a new document, or editing an existing one, the Navigation Pane can be a 
useful tool for taking a quick look at your document's structure or for verifying whether or not 
appropriately nested heading styles have been applied. 

To Open the Navigation Pane: 

1. Click the View tab on the Ribbon. Locate the Show group and place a check in the box next to 
Navigation Pane. 

 

2. The Navigation Pane appears on the left side of the screen. If heading styles are used in the 
document, they will appear here. 

 

3. To jump to a new location in the document, click a heading in the Navigation Pane. 
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Apply Bulleted and Numbered Lists 

Lists are useful for organizing items or drawing attention to important information. Using Word's Bullets 
and Numbering list options will structure your lists so that they appear uniform and tidy, and they will 
be easy to reformat, if desired.  

Additionally, screen reading software will announce when focus has arrived at a properly formatted list, 
informing the user to expect a series of items.  

To Structure a List in Word: 

1. Place the cursor in the location where you want to begin the list. 

 
 

2. On the Home tab, locate the Paragraph group. Taking into consideration the type of list you 
would like to create, click the Bullets option or the Numbering option. 

 

3. Depending on your selection, a bullet or a number will appear. Type the first list item. 
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4. To create the next list item, press Enter. 

 

5. To leave the list, press Enter twice. 

 

Other Bullet and Numbering Options 

For more bullet or numbering options in Word, click the drop-down arrow next to a list option. 
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 Step 3: Ensure all Images are Accessible 

Images can perform a variety of useful tasks, such as supplementing your lecture content or providing 
thoughtful imagery for discussion. To make them available to students unable to see them, they need 
text representation, called alternative text.  

Adding Alternative Text to an Image in Word 

1. After inserting an image, right-click the image and select Edit Alt Text from the menu that 
appears. 
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2. The Alt Text pane appears on the right. Type the image’s text representation in the box. (Note: 
Do NOT check the box next to Mark as decorative. This feature does not yet work properly.) 

 

3. Close the Alt Text pane by clicking the X in the upper-right corner. 
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Determining When to Use Long Description 

Often, a long description will be required for more complex or educational graphics. When the 
information portrayed in an image requires more text representation than what can be provided in its 
succinct alternative text, a long description will provide the means by which you can further describe an 
image.  

All students can benefit from having access to the long description; they will have access to the 
information you have decided is important for them to know about the image. (See Appendix A for more 
information on providing long descriptions.) 

Adding a Long Description to an Image in Word 

1. Type the long description near the image. For example, as a paragraph after the image.  

2. IMPORTANT! Type the location of the long description in the image’s alt text so the student 
using assistive technology will know where to find it. 

 

 Step 4: Compose Descriptive Hyperlinks 

When creating a hyperlink, use descriptive language that specifies the purpose of the link. This is usually 
a few words, or a succinct description, stating where the link leads. 

When creating a hyperlink in Word, first determine whether it is to a webpage or to a downloadable 
file.
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Creating a Hyperlink to a Webpage 

If creating a hyperlink to a webpage, first visit the website and copy the page’s address (URL). 

 

To Create a Hyperlink in Word: 

1. Type the descriptive hyperlink text, and highlight it. (Remember to indicate in the hyperlink text 
that the link will open a new tab/window.) 

 

2. Highlight and right-click the hyperlink text. Select Link from the menu that appears. 
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3. A dialog box appears. In the Address field, paste the address (URL). Click OK. 

 

4. The hyperlink is active (clickable). 

 

If you think the document will likely be printed, it is recommended that you paste the address (URL) 
near the active hyperlink as a courtesy. (Pasting the address is not necessary for accessibility 
compliance; however, it is useful when the content is printed, and if the URL is longer, you can shorten it 
using Bitly.com or shorturl.at.) 

Creating a Hyperlink to a File 

If you’re creating a link to a downloadable file, indicate the type of file in the active hyperlink text. This 
helps make students aware that they will be downloading a file.  

● If the file is a: 
o Word document, then use (doc or DOC) 
o Adobe PDF file, then use (pdf or PDF) 
o PowerPoint presentation, then use (ppt or PPT) 
o Text file, then use (txt or TXT) 
o For example: North Carolina Climate Science Report (PDF) 

(If you’d like, you can substitute Word doc for DOC, PowerPoint for PPT, etc. The important measure 
you are taking is indicating the type of file.) 

https://ncics.org/wp-content/uploads/2020/06/NC_Climate_Science_Report_FullReport_Final_revised_May2020.pdf
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 Step 5: Create Accessible Tables 

An accessible table generally contains simple data or structured information that is logical from left to 
right, top to bottom. It will have a title and a header row.  

 

To Create a New Table: 

1. Select the Insert tab on the Ribbon.  

 
2. Click the Table command. A drop-down menu containing a grid of squares will appear. Hover the 

mouse over the grid to select the number of columns and rows in the table.  

 
3. Click the mouse, and the table appears in the document. 
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Formatting a Table for Accessibility 

Adding a title and denoting the header row help make a table more accessible. 

To Add a Title 

Providing a title introduces the table to someone using assistive technologies, and it will also help 
identify the table’s content for everyone. Word identifies a title as a caption. 

1. Hover the mouse over the table. A plus sign appears in the upper-left corner. 

 

2. Right-click the plus sign and select Insert Caption. 

 



Page 51 
 

3. A dialog box appears. In the Caption: field, type a title for the table and click OK. 

 

4. The caption/title appears above the table. 

To Identify the Header Row 

1. Highlight the top row and right-click. Select Table Properties from the menu that appears. 
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2. A dialog box appears. Select the Row tab, and place a check in the box next to Repeat as header 
row at the top of each page. 

 

Other Accessibility Considerations When Creating Tables 

● Avoid Blank Cells. If a blank cell is needed in your table, type blank cell or data not available (or 
another word that makes sense in the context of the table, such as data unknown) in the cell. If 
the visual appearance of a blank cell is desired, you may change the font color of this text to 
match the cell’s background color. 

● Avoid Merging or Splitting Cells. When merged or split cells are present, the table will become 
inaccessible by either causing the screen reading software to repeat information or skip around 
in the table. The result is disorienting for the listener and the table's format can be confusing for 
other students to interpret. 

• Avoid creating page layouts with tables. Tables should be used to present data or structured 
information. 

• Avoid creating blank rows or columns to visually control the spacing in your table. Adjust line 
spacing instead. 

Restrict Rows from Breaking across Pages 

When a table becomes large enough that it needs an additional page to display all of the content, 
restricting the table’s ability to break rows across pages will help keep each row’s information intact and 
easier to follow.  
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● In the example below, Row 3 is breaking across pages.

 

● Restricting the table’s ability to break rows across pages moves the broken row (Row 3) to the 
next page.

 

To restrict rows from breaking across pages: 

1. Select the entire table. 
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2. Right-click, and choose Table Properties from the menu that appears.  

 

3. Select the Row tab, and uncheck the box next to Allow row to break across pages. 

 

4. Click OK. The rows will no longer break across pages. 

Step 6: Running the Accessibility Checker 

Microsoft Word has a built-in Accessibility Checker that can help you verify the accessibility compliance 
of documents. The Accessibility Checker scans the file and looks for content that could be a potential 
barrier or issue for people with disabilities.  
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To Activate the Accessibility Checker: 

1. Click the File tab to access Backstage View. 

 
 

2. Make sure Info is selected on the Backstage View menu, and then click the Check for Issues 
drop-down. Select Check Accessibility. 

 

Addressing Accessibility Issues 

When the Accessibility Checker detects one or more accessibility issues, a list of Errors and Warnings 
appears in its Inspection Results. From the Accessibility Checker’s Inspection Results, select an issue. 
The inaccessible content becomes highlighted in the document, and information about how to fix the 
issue appears under the Additional Information area of the Accessibility pane (see Figure 21). 
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Figure 21: The Accessibility pane in Microsoft Word 

FAQ: Can I trust the Accessibility Checker to catch everything? 

Unfortunately, no. While the Accessibility Checker catches some accessibility issues, it does not take the 
place of human review. For detailed information on the errors and warnings the Accessibility Checker 
currently looks for, please visit:  

Microsoft’s Accessibility Checker Rules page  
URL: https://bit.ly/3uvRaht
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Part 5: Authoring Accessible PowerPoint Presentations 

Step 1: Consider Color Contrast and Accessible Font Styles 

Microsoft Office offers a number of colors and themes that can be applied to slides in PowerPoint. If you 
wish to use a theme, consider each one carefully for proper color contrast and a readable font style and 
size. 

 

You can check the color contrast in a couple of ways: 

● With your printer's black and white option, print a page to check whether or not the contrast is 
sufficient. 

● Test the foreground and background color with the Color Contrast Analyzer by TPGi (see Part 7 
for a link to the TPGi Color Contrast Analyzer.) 

Other Accessible Color, Contrast, and Font Considerations 

● When using color to convey information, reinforce the color with text (or symbols) so people 
who cannot perceive color can access the information. 

● Fonts should be readable. 
● Limit the number of fonts.  
● Avoid using ALL CAPS or all underlined text. 
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 Step 2: Structure the Presentation 

When you’re ready to add content to a slide, PowerPoint has a number of built-in slide layout 
templates, many of which contain placeholders for entering text, lists, images, tables, and more. Using 
slide layout templates will structure the content of your presentation, making it easier for your students 
to understand the information, as well as making it accessible to assistive technology.  

 
Figure 22: Title Slide layout template 

The Title Slide layout template in Figure 22 is one of the templates in PowerPoint's collection of slide 
layout templates.  

Considering Slide Layout Templates 

The variety of slide layout templates offered in PowerPoint allows you to select a placeholder 
arrangement that best suits the style in which you wish to present your content. Figure 23 presents 
PowerPoint’s default collection of slide layout templates (see Figure 23). 
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Figure 23: PowerPoint's collection of slide layout templates 

Avoid using the Blank slide layout template 

If you prefer to start with a "blank slate" in PowerPoint, it can be tempting to select the Blank slide 
layout and build upon it. However, starting from a blank slide and adding content to it is inaccessible 
because screen reading technology may not be able to find the content. Though located within the list 
of slide layout templates, the Blank slide is not a template, and unfortunately, does not provide the 
necessary structure. 

 
Figure 24: Avoid the blank slide layout 

Rather than selecting the Blank slide, use one of the slide layout templates that has content 
placeholders.  

Avoid adding text boxes to slides 
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Text boxes are very difficult for users of assistive technology to navigate, and they may not convert well 
into other formats such as PDF, Braille, or large print. Think of text boxes as objects that "float" above 
the slide and are very difficult to reach by assistive technology. This potentially creates a barrier to your 
content. 

 
Figure 25: Avoid drawing a text box on a slide 

Instead, select a slide layout template that has at least one placeholder. 

Avoid using the Insert tab to insert pictures (or other objects) to slides 

Similar to text boxes, images inserted with the Insert tab are also difficult for users of assistive 
technology to navigate, and when the presentation is converted into other formats such as PDF, Braille, 
or large print, an image inserted with this technique may not be available to an assistive technology 
user. Like text boxes, images inserted with the Insert tab also "float" above the slide, potentially creating 
a barrier to your content. 

 
Figure 26: Avoid inserting a picture through the Insert Tab 

 

Instead, select a slide layout template that has at least one content placeholder. Specifically: Title and 
Content, Two Content, Comparison, Content with Caption, or Picture with Caption. 
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Figure 27: Five slide layouts have  
at least one content placeholder 

Then, once a slide layout template with a content placeholder is selected, click the Pictures icon to 
insert an image. 

 
Figure 28: The Pictures icon in the placeholder
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To Create a New Slide: 

1. From the Home tab, click New Slide, and then select a layout template. 

 

2. The new slide appears. Click a placeholder to add your content. 
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To Modify the Layout of an Existing Slide: 

1. Select the slide you wish to change. 

 

2. From the Home tab, click Layout and select a layout template. 

 



Page 64 
 

3. The new template appears on the slide. 

 

Bulleted and Numbered Lists in PowerPoint 

When developing text content, avoid writing paragraphs or long passages in the content placeholders. 
Instead, use PowerPoint's bulleted and numbered list commands to help structure the text on your 
slide. Using lists will make the content more manageable for students to digest, and screen reading 
software will announce when it has arrived at a list, informing the user to expect a series of items. 

By default, many content placeholders in PowerPoint will begin to format your text as a bulleted list as 
soon as you start to type; however, you can also create a numbered list. 

To Create a Bulleted List: 

1. Make sure you have selected a template that contains at least one content placeholder. Click 
the content placeholder and type the first list item. By default, the content placeholder will 
format the text as a bulleted list item. 

2. Press Enter to move the cursor to the next line. 
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To Create a Numbered List: 

1. Highlight the list items you want to number. 

 

2. Locate the Paragraph group on the Home tab, and click the Numbering option. 

 

3. The list becomes numbered. 
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Viewing a Presentation in Outline View 

Beyond accessibility, one of the benefits of utilizing PowerPoint's placeholders is the ability to view 
an outline of the presentation to verify its structure. Outline View, located on the View tab, displays all 
of the text content that has been added to each slide's title and content placeholder(s). It provides an 
easy way to make sure all of your slide titles are unique and all of your text content is available to screen 
reading technology. 

Once you've created some content, you can then verify the presentation's structure in Outline View. 

1. Click the View tab, and select Outline View. 

 

2. The Outline pane appears on the left side of the screen. Check to make sure each slide has a 
unique title and that all of the slide text is appearing. (Note that each slide title appears as bold 
text.) 
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 Step 3: Ensure all Images are Accessible 

Images can perform a variety of useful roles, such as supplementing your lecture content or providing 
thoughtful imagery for discussion. To make images available to students unable to see them, they need 
text representation, called alternative text. 

Adding Alternative Text to an Image in PowerPoint 

1. After inserting an image, right-click the image and select Edit Alt Text from the menu that 
appears. 

 

2. The Alt Text pane appears on the right. Type the image’s text representation in the box. (Note: 
Do NOT check the box next to Mark as decorative. This feature does not yet work properly.) 
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3. Close the Alt Text pane by clicking the X in the upper-right corner. 

 

Determining When to Use a Long Description 

Often, a long description will be required for more complex or educational graphics. When the 
information portrayed in an image requires more text representation than what can be provided in its 
succinct alternative text, a long description will provide the means by which you can further describe an 
image.  

All students can benefit from having access to the long description; they will have access to the 
information you have decided is important for them to know about the image. (See Appendix A for more 
information on providing long descriptions.)



Page 69 
 

Adding a Long Description in PowerPoint 

Depending on the amount of space needed for the long description text, the long description can be 
typed in the Notes area of a slide or included as a list on the slide itself. (If a paragraph is needed, it’s 
best to type the long description in the Notes area.)  

IMPORTANT! Type the location of the long description in the image’s alt text so any student using 
screen reading technology will know where to find it. 

 
Figure 29: Viewing the long description for an image in the Notes area of a slide, as well as the image's 
alternative text in the Alt Text pane. 

 Step 4: Compose Descriptive Hyperlinks 

Hyperlinks in PowerPoint can be tricky, in general, for assistive technology users to navigate. Use 
descriptive language that specifies the purpose of the link. This is usually a few words, or a succinct 
description, stating where the link leads. 

When creating a hyperlink in PowerPoint, first determine whether it is to a webpage or for a 
downloadable file.
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Creating a Hyperlink to a Webpage 

If creating a hyperlink to a webpage, first visit the website and copy the page’s address (URL). 

 

To Create a Hyperlink in PowerPoint: 

1. Type the hyperlink text. To help ensure the student is alerted to the presence of a hyperlink to a 
webpage, always include: (link) as part of the hyperlink text.  
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2. Highlight the hyperlink text and right-click. Select Hyperlink from the menu that appears. 

 

3. A dialog box appears. In the Address field, paste the address (URL). Click OK. 

 

4. The hyperlink is active (clickable). 
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5. If you think the document or presentation will likely be printed, as a courtesy you can paste the 
address (URL) near the active hyperlink. (Pasting the address is not necessary for accessibility 
compliance; however, it is useful when the content is printed, and if the URL is longer, you can 
shorten it using Bitly.com or shorturl.at.) 

 

Creating a Hyperlink to a File 

If you’re creating a link to a downloadable file, indicate the type of file in the active hyperlink text. This 
helps make students aware that they will be downloading a file.  

● If the file is a: 
o Word document, then use (doc or DOC) 
o Adobe PDF file, then use (pdf or PDF) 
o PowerPoint presentation, then use (ppt or PPT) 
o Text file, then use (txt or TXT) 
o For example: North Carolina Climate Science Report (PDF) 

(If you’d like, you can substitute Word doc for DOC, PowerPoint for PPT, etc. The important measure 
you are taking is indicating the type of file.) 

 Step 5: Create Accessible Tables 

In PowerPoint, tables work well when they are used to present simple, uncomplicated data or other 
information, such as a simple schedule. Screen reading software reads the table from left-to-right, top-
to-bottom. Keeping this knowledge in mind will help you plan the content of your table so that it is 
intuitive for all students regardless of how they might access it. 

Figure 30 provides an example of an accessible table in PowerPoint 

https://ncics.org/wp-content/uploads/2020/06/NC_Climate_Science_Report_FullReport_Final_revised_May2020.pdf
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Figure 30: Example of a simple table on a PowerPoint slide 

To Create an Accessible Table 

1. Select a slide layout template that contains a Title placeholder and at least one content 
placeholder. In the Title placeholder, type a title for the slide that describes the purpose of the 
table. Include the word Table in the title so that this slide is easy to locate in Outline view. 

 

2. Click the Insert Table command. 
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3. The Insert Table dialog box appears. Select the number of columns and rows you need and then 
click OK. 

 

4. A new, blank table appears on the slide. In the first row, type a name for each column. The first 
row is automatically assigned a header row in PowerPoint. 

 

5. Continue to enter information into the table until all of the cells have been used. 
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A Note about Color Contrast and Tables 

If you are using a built-in PowerPoint theme, it's important to check the color contrast of the table and 
adjust the colors, if needed. To change the table's colors, click the Table Design tab and select a theme 
from the Table Styles group. 

 
Figure 31: The Table Styles group on the Table Design tab provides a number of formatting options 

Other Accessibility Considerations When Creating Tables 

● Avoid Blank Cells. If a blank cell is needed in your table, type blank cell or data not available (or 
another word that makes sense in the context of the table, such as data unknown) in the cell. If 
the visual appearance of a blank cell is desired, you may change the font color of this text to 
match the cell’s background color. 

● Avoid Merging or Splitting Cells. When merged or split cells are present, the table will become 
inaccessible by either causing the screen reading software to repeat information or skip around 
in the table. The result is disorienting for the listener and the table's format can be confusing for 
other students to interpret. 

• Avoid creating blank rows or columns to visually control the spacing in your table. Adjust line 
spacing instead. 
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Step 6: Running the Accessibility Checker 

Microsoft PowerPoint has a built-in Accessibility Checker that can help you verify the accessibility 
compliance of presentations. The Accessibility Checker scans the file and looks for content that could be 
a potential barrier or issue for people with disabilities.  

To Activate the Accessibility Checker: 

1. Click the File tab to access Backstage View. 

 

2. Make sure Info is selected on the Backstage View menu, and then click the Check for Issues 
drop-down. Select Check Accessibility. 
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Addressing Accessibility Issues 

When the Accessibility Checker detects one or more accessibility issues, a list of Errors and Warnings 
appears in its Inspection Results. From the Accessibility Checker’s Inspection Results, select an issue. 
The inaccessible content becomes highlighted in the presentation, and information about how to fix the 
issue appears under the Additional Information area of the Accessibility Checker pane. 

 
Figure 32: The Accessibility Pane  

in Microsoft PowerPoint 

FAQ: Can I trust the Accessibility Checker to catch everything? 

Unfortunately, no. While the Accessibility Checker catches some accessibility issues, it does not take the 
place of human review. For detailed information on the errors and warnings the Accessibility Checker 
currently looks for, please visit:  

Microsoft’s Accessibility Checker Rules page  
URL: https://bit.ly/3uvRaht 
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Part 6: A Note on Universal Design for Learning 

To enhance the learning experience, consider implementing Universal Design for Learning (UDL), which 
is a framework for curriculum development that gives all individuals equal opportunities to learn. Think 
of UDL as a blueprint, based on the learning sciences, for creating instructional goals, methods, 
materials, and assessments that work for everyone.  

While comprehensive information about how to implement Universal Design for Learning in your class is 
outside the scope of this handbook, a lot of great information is provided on the CAST Universal Design 
for Learning site (opens new window) (see Part 7 for the URL to this site). 

We mention UDL in this accessibility handbook because UDL strongly supports digital accessibility for its 
instructional benefits. In a nutshell, UDL has three primary principles: 

● Provide multiple means of engagement 
● Provide multiple means of representation 
● Provide multiple means of action and expression 

When you ensure the accessibility of your digital content, you readily satisfy many of the checkpoints 
outlined in the Multiple Means of Representation principle. We’ve included a few instructional strategies 
below that help further illustrate the relationship between digital accessibility and UDL. 

Strategies for Presenting PowerPoint Presentations 

Pair an accessible PowerPoint presentation with a typed lecture, video, or a follow-up activity. By doing 
this, you increase the ways in which your content is represented to students, allowing them a more 
diverse experience with the material. 

● Narrate your presentation directly in PowerPoint. The presentation can be saved as a video, and 
the video uploaded to YouTube and easily captioned. (A link to instructions on how to narrate a 
PowerPoint presentation is provided in Part 7:Resources.) 

● Type your accompanying lecture, accessibly, in Word. Make sure to let students know which 
slide(s) you are referencing. 

● Audio record the lecture and upload it with the accessible presentation and a transcript of the 
recording. Make sure to let students know which slide(s) you are referencing. 

Strategy for Providing Long Description for Complex Instructional Images 

Audio record a long description of the image and provide a text transcript of the recording.

 

http://udloncampus.cast.org/page/udl_landing
http://udloncampus.cast.org/page/udl_landing
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Part 7: Resources 

Color and Contrast 
● Download the Color Contrast Analyser by TPGi 

URL: https://www.tpgi.com/free-accessibility-testing-tools/#colour 

o Using the TPGI Color Contrast Analyzer (YouTube video) 
URL: https://youtu.be/Gtlvc3s2ii8 

● Effective Color Contrast: Designing for People with Partial Sight and Color Deficiencies 
URL: https://bit.ly/3FbiaaW 

PowerPoint Presentations 
● How to Record a Slide Show with Narration and Slide Timings 

URL: https://bit.ly/2Y8yGHC 

Portable Document Format (PDF) Documents 
● Access for All’s Free PDF Accessibility Checker (PAC 3) 

URL: https://www.access-for-all.ch/en/pdf-accessibility-checker.html 

● WebAIM’s PDF Accessibility Article Converting Documents to PDFs  
URL: https://webaim.org/techniques/acrobat/converting 

Universal Design for Learning 
● Universal Design for Learning in Higher Education 

URL: http://udloncampus.cast.org/page/udl_landing 

VLC Contact Information 
● Submit your question or request through the VLC Contact Us page: 

URL: https://vlc.nccommunitycolleges.edu/contact/ 

Other Digital Accessibility Resources 
● NCDAE Accessibility Cheat sheets 

URL: https://ncdae.org/resources/cheatsheets/ 

● WebAIM’s Document and Media Accessibility 
URL: https://webaim.org/articles/#richmedia 

● W3C’s Teach and Advocate Overview 
URL: https://www.w3.org/WAI/teach-advocate/
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Appendix A 
Text Representation (alt text) for Complex (STEM) Images 

Understanding Long Description for STEM Images 

Alternative text AND a long description are required for more complex educational images, such as 
Science, Technology, Engineering, and Math (STEM) images. Depending on the type of complex image, 
use one of three long description strategies: Linear Description, List Description, or Table Description. 

Table A1: Complex Image Long Description Strategies 
Long Description 

Strategy Type of Complex Image Description of Strategy 

Linear Description ● Venn diagrams 
● Educational illustrations 
● Comparison illustrations 

A linear description is a traditional 
description of an image. It organizes the 
content in the graphic by describing it from 
left to right (or top to bottom). To provide a 
linear description, begin by selecting a spot, 
providing a description for it, and then 
moving in a sequential, logical narrative 
from that first point to the next spot and 
beyond. Try to be brief and specific. 
 
Linear Description Example 

List Description ● Image of a process 
● Image of a cycle (i.e., a life 

cycle) 
● Flow chart 

A list description is a numbered (or 
otherwise ordered, such as 
alphabetized) list. Start at the beginning of 
a process (or in the case of a cycle, pick a 
point within the cycle in which to 
begin), and type a list of all of the steps 
involved in the process. 
 
List Description Example 

Table Description ● Bar charts 
● Line graphs 
● Pie charts 
● An illustration that has an 

embedded graph or chart 
● Complex diagram 

A table organizes data from images of 
charts and graphs. In Word, create an 
accessible table of the data appearing in 
the chart or graph. 
 
Table Description Example 
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Linear Description Example 

In this example, the long description (linear description) of the Venn diagram is provided below the 
image: 

 

Long description of Venn diagram comparing and contrasting Scientific Revolution and Technological 
Revolution: This Venn diagram has two overlapping circles. One is labeled Scientific Revolution and the 
other is labeled Technological Revolution. Scientific Revolution includes: 16th Century, Completely new 
inventions, and Physical science. Technological Revolution includes: 21st Century, Mostly enhanced 
previous inventions, and Technological science. The circles overlap in the middle and include: New 
technology, Encourages new way of thinking, Reinvents concept of education, Develops global 
communication, and New perspective.  

The alt text provided for the image above is:  

Venn diagram comparing and contrasting Scientific Revolution and Technological Revolution. Long 
description provided below image (see Figure 33). 

 
Figure 33: Word's Alt Text pane  

for the Venn diagram image 
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List Description Example 

In this example, the long description (list description) of the lunar cycle is provided below the image:  

 

Long description of lunar phases cycle: 15 photographs of the moon documenting its lunar phases. The 
list below provides a description of the photographs: 

1. The Moon's unilluminated side is facing the Earth. The Moon is not visible. 
2. The Moon appears to be partly but less than one-half illuminated by direct sunlight. The 

fraction of the Moon's disk that is illuminated is increasing. 
3. One-half of the Moon appears to be illuminated by direct sunlight. The fraction of the 

Moon's disk that is illuminated is increasing. 
4. The Moon appears to be more than one-half but not fully illuminated by direct sunlight. 

The fraction of the Moon's disk that is illuminated is increasing. 
5. The Moon's illuminated side is facing the Earth. The Moon appears to be completely 

illuminated by direct sunlight. 
6. The Moon appears to be more than one-half but not fully illuminated by direct sunlight. 

The fraction of the Moon's disk that is illuminated is decreasing. 
7. One-half of the Moon appears to be illuminated by direct sunlight. The fraction of the 

Moon's disk that is illuminated is decreasing. 
8. The Moon appears to be partly but less than one-half illuminated by direct sunlight. The 

fraction of the Moon's disk that is illuminated is decreasing.  

The alt text provided for the image above is:  

Lunar phases cycle. Long description provided below image.
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Table Description Example 

In this example, the long description (table description) of the pie chart is provided below the image:  

 

Long description of pie chart depicting percentage of professionals who were awarded Medicare EHR 
Incentive payments, by amount in 2012. The table below provides a description of the data depicted in 
the pie chart: 

Table A2: Data depicted in pie chart 
Amount (in dollars) Percentage 

18,000 63% 
12,000 10% 

Greater than or equal to $12,000, but less than 
$18,000 

27% 

The caption below the image provides attribution information:  

Figure 2: Percentage of Professionals Who Were Awarded Medicare by U.S. GAO (2013) 
https://www.flickr.com/photos/58220939@N03/10691813934/ United States Government Work 
(http://www.usa.gov/copyright.shtml) Photo Attribution by PhotosForClass.com 

The alt text provided for the image above is:  

Pie chart depicting percentage of professionals who were awarded Medicare EHR Incentive payments, by 
amount in 2012. Long description provided below image. 
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Long Description FAQs 

FAQ: How do I know when to use a long description? 

If the image for which you are providing alternative text is one of the following types of complex images, 
it will likely require a long description in addition to the alternative text: 

● Venn diagram 
● Image of a process 
● Image of a cycle (i.e., a life cycle) 
● Flow chart 
● Bar chart 
● Line graph 
● Pie chart 
● An educational illustration 
● Comparison illustration 
● An illustration that has an embedded graph or chart 
● Complex diagram 

FAQ: Where do I type the long description? 

Determine the format in which you want to provide the long description: 

● Option A (Ideal for instruction and Word documents): Typed under (or near) the image.  
● Option B: (A good choice for images embedded in the LMS): In a separate Word document or 

text document. You will upload the long description file to your class site’s Resources area, and 
then create a link to it under the image. 

● Option C: (In PowerPoint ONLY): Typed in the Notes area under the image’s Slide. 

FAQ: Do I have to type an alternative text when I create a long description? 

Yes. Assistive technology will access the image’s alternative text regardless of whether or not a long 
description is provided. Use the alternative text to succinctly replace the image and inform the student 
of where to locate the long description. 
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Appendix B 
Creating an Accessible PDF File from a Word 2019 Document 

Preparing the Word Document 

Use Word’s Built-in Features 

● Headings – nest properly (like an outline) 
● Numbered or Bulleted Lists 
● Inserting tables 
● Table of Contents (for longer documents) 

Create Accessible Tables 

If a table is present in the document: 
● Perform the “Tab test” on the Table 

o Place the cursor in the first cell and press Tab to make sure the cursor moves to the 
right, and then automatically down to the next row.  

o If you are unable to place the cursor in the table, the table may be an image (and will 
require alternative text and a long description) 

● Make sure the table has a title (in Word, this is called a caption) 
● Denote the Header Row (make sure each of the column headings is descriptive) 
● Keep the table simple 

● Avoid merging or splitting cells 
● Avoid blank cells 

Check for Accessibility 

● Ensure Heading Styles have been applied to the document’s title and section subheadings. 
o Open the Navigation Pane – are the headings descriptive? 

● Review any hyperlinks to ensure they are descriptive. 
● Ensure all images have alternative text (and a long description, where needed). 
● Use the Accessibility Checker (File > Check for Issues > Check for Accessibility). 
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To Create a PDF File 

1. In Word, click File. 

2. Select Save As.  

 

3. Select a location for the file, and a dialog box appears. Click the Save as type drop-down. 
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4. Then select PDF (*.pdf). 

 

5. Click the Options button. 

 

6. A dialog box appears. Place a check next to the following options: 
✔ Create bookmarks using – Headings 
✔ Document structure tags for accessibility 

 

7. Click OK and then Save. The PDF file is created.
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Appendix C 
Accessible Math using MathType 

Introduction 

MathType is an equation editor that allows for the rich display of mathematical numbers, symbols, and 
equations on the Microsoft Windows and Apple Macintosh platforms. MathType expands on the basic 
equation editor symbol set and provides additional equation and notation options for the display of 
mathematical content.  

MathType is commonly used within Microsoft Office applications (e.g., MS Word and PowerPoint) or the 
Apple iWork suite (e.g., Pages and Keynote), to author mathematical symbols and other science 
notation. MathType is also a major component in supporting the conversion of documents into 
accessible alternate formats that include mathematical content. 

Adding Equations in Microsoft Word 

Once MathType has been installed, an additional tab called the MathType ribbon will appear in the 
Microsoft Word interface. There are two methods to add an equation to a document, the MathType 
interface equation editor or by using LaTex. 

Using the MathType Interface 

Select the MathType tab to switch to the MathType ribbon and select either the Inline Equation or 
Display Equation option. An Inline Equation will add a MathType object within the same line as the 
cursor focus. A Display Equation will add a MathType object centered and on a new line. 

 

MathType will automatically open the MathType interface. To enter numbers or letters, use the 
keyboard to enter the relevant characters. MathType automatically adjusts the spacing and formatting 
for "math" specific content; as a result, the space bar is disabled to prevent unintended spacing in the 
equations. 
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To save the equation back into the Microsoft Word document, choose File > Close and Return to 
Document (Ctrl+F4). This will save the current MathType object and return you back to the original 
document. 

For entering symbols, such as the radical symbol or fraction symbol, use the templates provided just 
above the MathType editing window. These symbol templates provide a mechanism to control the 
placement of numbers or other characters in order to properly display the equation. 

Example Equations with Fractions 

1. To enter an equation with a fraction, use the fraction template to establish the numerator and 
denominator template regions (hotkey command Ctrl+F). 

2. Enter the appropriate value for either the numerator or denominator. 
3. Switch between the numerator and denominator regions by using the up or down arrow keys. 
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4. To exit the numerator or denominator regions, press the right arrow key to move the cursor 
focus outside of the fraction. 

5. Return to the document by choosing File > Save and Close (Ctrl+F4). 

Using LaTex with MathType 

You can type LaTeX directly into your Microsoft Word document: 

1. Type the TeX and highlight. 
2. In the Publish group, click on the Toggle/TeX command.  
3. The Toggle/TeX command converts TeX code into MathType objects that can be saved and 

rendered into MathML.  

 

MathType Keyboard Commands 

MathType provides a large number of keyboard commands to simplify the authoring or editing of 
mathematical symbols and equations. For instance, Ctrl+F will automatically include the fraction 
template whereas Ctrl+R will embed the square root symbol into the editing region. 

To review all the keyboard commands or change the current keyboard mapping, in MathType go to 
Preferences > Customize Keyboard. Expand open the menu list of keyboard commands to review the 
currently established options or to set new keyboard commands. 
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The current shortcut keys will be displayed in the "Current Keys" region. If you wish to return all the 
keyboard commands to the original settings, press the "Reset All" button. This will reset all the keyboard 
commands to the default settings when MathType was first installed. 

Appearance of Math Content 

One challenge when working with MathType is that it can be difficult to discern which parts of the 
document are text-based and which parts of the document are MathType objects. There are two 
methods one can use to differentiate between the text content and MathType objects: adjusting the 
color of MathType objects or browse the equations in the document. 

Adjusting the Color of MathType Objects 

You can set MathType objects so that they may be a different color than the surrounding text-based 
information. 

1. To change the color of an equation, double-click on the equation to open the MathType 
window. 

2. Select the entire equation (Ctrl-A). 
3. Choose Format > Color, and then select the color you wish to use to represent the equations. 

The color you choose will be represented in the final version of the document, so ensure 
appropriate color contrast. 
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4. To change all future equations to be of the same color, choose Format > Color > Edit Color 
Menu. 

5. Choose your desired color and press the Set as Default button. This will set the color for future 
MathType equations.

 

Browse by Equation 

In addition to setting the color for a MathType equation, it is also possible to navigate through the 
document from equation to equation skipping the text-based content. Locate the Equations option in 
the Browse group. To move from equation to equation, press the Previous or Next button (in the Browse 
region) to move by MathType objects through the document. 

 

Browsing by equation will allow you to quickly jump from one equation to the next and provide a visual 
indicator of the equation in the document. This can be useful if you do not wish to change the color of 
the equation as described in the previous section. This can also be a useful method to evaluate if there 
are any "empty" MathType objects in the document. 
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Export to the Web 

MathType offers numerous export options for equations authored within the MathType interface. To 
ensure a version of the document is compatible with assistive technology, it is necessary to use the 
Publish to MathPage export option. Please note - this is different than using the Save As Web page 
option from within the Microsoft Office  

Example: Exporting as a Web Page 

1. Create your document and add the relevant MathType objects. 
2. Save the document. 
3. Choose Publish to MathPage in the MathType ribbon.

 

In the Publish to MathPage dialog box, provide a title for the document. This will become the title of the 
Web page that is displayed at the top of the browser (this creates the <title> tag). 

Check the location of where the file will be stored in the File Name region. To change the file save 
location, press the Browse button and select a new file location.

 

In the Equations section, click the radio button MathML using: and select the option "HTML+Mathjax". 
This will create a Web page with MathML content compatible with most Web browsers. 
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Open the resulting file using a Web browser (e.g. Chrome, Safari, Firefox, Opera etc.).  
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